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lekcija 2

 

Dodavaçe sadræaja 
Web strani 

 

Ova lekcija vas uåi kako da uvezete tekst u razliåitim formatima i kako da prila-

godite materijal iz razliåitih operativnih sistema. Nauåiñete i kako da zadate 

podrazumevane parametre dokumenta, kako da formatirate tekst u nekoliko 

razliåitih tipova lista i kako da koristite fontove i razliåite veliåine slova da biste 

podesili tekst na strani. Formatiraçe teksta je veoma bitno za åitkost i vizuelnu 

privlaånost Web strana. Tekst moæe biti glavni deo strana; odvojte dovoàno 

vremena za organizovaçe i formatiraçe materijala da bi posetioci mogli brzo 

i lako da ga proåitaju.

 

U ovoj lekciji ñete, 

dok radite na Web 

prezentaciji 

“Lights of the 

Coast”, nauåiti 

kako da stranama 

dodate sadræaj i 

kako da formati-

rate tekst. Pored 

toga, nauåiñete 

kako da testirate 

strane i kako da 

koristite Flash 

tekst.
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Zavrãen primer iz ove lekcije nalazi se u poddirektorijumu Completed direktori-

juma Lesson_

 

02

 

_Content na kompakt disku.

 

ÃTA ÑETE NAUÅITI 

 

U ovoj lekciji ñete:

 

•

 

dodati tekst na stranu

 

•

 

napraviti liste

 

•

 

pozicionirati i formatirati tekst na strani

 

•

 

zadati podrazumevane parametre fonta i boje

 

•

 

zadati font, çegovu veliåinu i boju

 

•

 

ubaciti posebne znakove i druge elemente

 

•

 

napraviti i izmeniti Flash tekst

 

POTREBNO VREME

 

Za ovu lekciju biñe vam potreban otprilike jedan sat.

 

DATOTEKE LEKCIJE

 

Poåetne datoteke:

 

Lesson_02_Content\introduction.htm
Lesson_02_Content\Text/introduction.txt
Lesson_02_Content\Text/intorduction_mac.txt

 

Zavrãen projekat:

 

Lesson_02_Content\Completed\introduction.htm
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OSNOVNO FORMATIRAÇE TEKSTA

 

Tekst moæete da upiãete neposredno u dokument introduction.htm. U HTML-u 

su vam na raspolagaçu razne opcije za osnovno formatiraçe teksta. Veñina 

HTML formatiraça veoma je ograniåena – nemate najboàu kontrolu veliåine 

fonta, razmaka i poravnaça.

 

Ako hoñete boàe da upravàate izgledom teksta, morate koristiti 
kaskadne opise stilova – CSS (Cascading Style Sheets) da biste definisali izgled i poloæaj 
elemenata na strani. (Osnovno formatiraçe teksta pomoñu CSS-a objasniñemo kasnije u 
ovoj lekciji; kaskadni opisi stilova detaàno su opisani u lekciji 6.)

 

1)  

 

Otvorite datoteku introduction.htm iz direktorijuma Lesson_

 

02

 

_Content. U pro-

zor dokumenta upiãite 

 

Introduction to Lights of the Coast: Exploring Lighthouses

 

.

 

Ovaj poåetni dokument sliåan je onom iz lekcije 1.

Tekst ñe se pojaviti u prozoru dokumenta dok ga budete upisivali i to ñe biti 

naslov na strani.

 

2)  

 

Iz menija Format na panou Properties izaberite opciju Heading 4.

 

Upisani tekst ste definisali kao naslov åetvrtog nivoa. Tekst je formatiran kao ele-

ment na nivou bloka. Sve opcije odabrane u meniju Format odnose se na cele 

blokove teksta. Formatiraçe naslova, niti bilo koje drugo formatiraçe blokova, 

ne moæete primeniti na samo jednu reå ili na deo bloka teksta. Zbog toga ne 

morate da izaberete tekst da biste mu dodelili stil naslova – na sav tekst u bloku 

automatski se primeçuje formatiraçe koje ste odabrali iz menija Format.

 

Ostali elementi nivoa bloka jesu pasusi, liste, horizontalne linije i opcije 
poravnaça. U ovoj lekciji ñete nauåiti kako da radite s tim elementima.

 

Naslovi su prikazani veñim ili debàim fontovima od obiånog, glavnog teksta. 

HTML ima ãest nivoa naslova, s oznakama od Heading 1 do Heading 6. Naslov 

prvog nivoa, Heading 1, ima najveña slova, a naslov ãestog nivoa, Heading 6, naj-

maça. Kada pasusu dodelite HTML oznaku naslova (engl. 

 

heading

 

), automatski 

n a p o m e n a

n a p o m e n a

pano properties na kom se vidi meni �
format sa izabranom opcijom heading 4
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se ispod çega dodaje odreœen prazan prostor (belina), åija visina zavisi od nivoa 

naslova. Belinu moæete da kontroliãete samo ako za formatiraçe koristite kas-

kadne opise stilova.

Naslovi mogu biti korisni za deàeçe sadræaja u odeàke i stavàaçe akcenta na 

odreœene delove strane. Posetioci obiåno brzo pregledaju Web strane i ne åitaju sve 

na çima. Imajte to na umu da biste napravili Web strane koje ñe posetioci mnogo 

lakãe koristiti. Tehnike formatiraça koje ñete upoznati u ovoj lekciji pomoñi ñe 

vam da razdvojite sadræaj i napravite jasnu vizuelnu hijerarhiju.

 

U mnogim dokumentima, prvi naslov na strani jednak je naslovu pre-
zentacije. Ako dokument ima viãe delova, tekst prvog naslova treba da se odnosi na prvi 
deo dokumenta, npr. naslov prvog poglavàa. Prethodno zadati naslov prezentacije treba 
da odredi dokument u ãirem kontekstu, npr. da sadræi i naslov kçige i naslov poglavàa. 

 

3)  

 

Pritisnite Enter (Windows), odnosno Return (Macintosh).

 

Time ste ispod naslova “Introduction to Lights of the Coast: Exploring Light-

houses” dodali joã jedan red, koji je deo novog bloka teksta. On podrazumevano 

dobija HTML oznaku pasusa. Svaki novi pasus predstavàa zaseban blok teksta. 

Za obiåan tekst koristi se, po pravilu, format pasusa i on je odvojen od ostalih blo-

kova izvesnim prostorom: prazan red deli nov blok teksta od prethodnog bloka. 

Taj razmak se moæete kontrolisati samo ako za formatiraçe koristite opise stilova.

 

Da biste blok teksta formatirali kao pasus, odaberite opciju Para-
graph iz menija Format na panou Properties, ili iskoristite preåicu s tastature 
Ctrl+Shift+P (Windows), odnosno Command+Shift+P (Macintosh).

 

4)  

 

Snimite datoteku.

 

Kad god izmenite dokument, Dreamweaver dodaje zvezdicu (*) do imena dato-

teke na vrhu prozora dokumenta. Ona oznaåava da je datoteka promeçena, a da 

potom nije snimàena. Zvezdica ñe nestati kada snimite dokument. Åesto snimajte 

dokument da biste umaçili rizik od gubitka uloæenog rada kada se Dreamweaver 

ili operativni sistem sruãe.

 

PRELAMAÇE REDA

 

Ukoliko hoñete da napravite nov red, bez razmaka nakon prethodnog reda teksta 

(jednostruki prored u tekstu), moæete prelomiti red. Ta tehnika je korisna za 

adrese; na primer, kada hoñete da napravite nov red za svaki red u adresi, bez 

dodatnih belina izmeœu pasusa.

n a p o m e n a

n a p o m e n a
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U dokumentu introduction.htm postavite kursor u naslov, odmah ispred reåi 

“Exploring”. Pritisnite Shift+Enter (Windows), odnosno Shift+Return (Macin-

tosh).

 

Tekst iza kursora prelazi u sledeñi red. Red je prelomàen, a nije napravàen nov 

pasus, pa nema dodatnog razmaka izmeœu dva reda. 

 

Ako dvaput zadate prelom reda, tekst ñe izgledati kao nov pasus; 
meœutim, poãto niste zaista napravili nov pasus teæe ñete primeniti stilove formatiraça 
na tekst koji ima dva prelomàena reda, umesto samo jednog novog pasusa.

Red moæete prelomiti i tako ãto ñete odabrati Insert > HTML > Special Char-
acters > Line Break ili tako ãto ñete odabrati kategoriju Text na traci Insert, pritisnuti 
ikonicu menija Characters i odabrati opciju Line Break. Ikonica specijalnog znaka za 
prelom reda je BR jer je HTML oznaka za prelom reda <br>.

 

ZADAVAÇE PARAMETARA TEKSTA

 

Strani moæete da dodate tekst kopiraçem i prenoãeçem iz drugog dokumenta. 

Drugi naåin je da otvorite i Dreamweaver i aplikaciju iz koje hoñete da prenesete 

sadræaj (kao ãto su programi iz paketa Microsoft Office) i zatim da kopirate, i umet-

nete tekst u Dreamweaver, ili da tekst, ili neki drugi element, izaberete i prevu-

åete u Dreamweaver.

Dreamweaver moæe da otvori datoteke napravàene u programima za obradu 

teksta ili programima za prelom strana, ukoliko su snimàene kao ASCII datoteke 

(åist tekst). Tekstualne (.txt) datoteke se u Dreamweaveru uvek otvaraju u 

novom prozoru, u prikazu Code. Kada otvorite tekstualnu datoteku u Dream-

weaveru, tekst moæete kopirati i preneti u drugi dokument.

Jednostavno formatiraçe, kao ãto je prelazak u novi red, moæete da zadræite, 

ali da biste to uåinili treba da razumete razlike izmeœu ASCII formata na razliåi-

tim platformama. Datoteke napravàene u Windowsu imaju nevidàiv kontrolni 

znak za prelazak u novi red – LF (engl. 

 

line feed

 

), kao i CR (engl. 

 

carriage return

 

), 

koji oznaåavaju mesto u tekstu gde poåiçe novi red. Macintosh raåunari ne kori-

ste znak LF, veñ samo znak CR. Unix koristi samo znak LF.

n a p o m e n a

poreœeçe prelomàenog reda i novog pasusa

belina ispod pasusa

prelom reda

dva preloma reda

s a v e t 1
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Da biste tekst ispravno uvezli iz ASCII datoteka i zadræali formatiraçe redova, 

morate Dreamweaverov parametar Line Break Type podesiti tako da odgovara 

operativnom sistemu u kom su nastale tekstualne datoteke koje ñete uvesti. Sle-

deña veæba objaãçava kako da to uradite.

 

1)  

 

Izaberite Edit › Preferences (Windows), odnosno Dreamweaver › Preferences 

(Macintosh) da biste otvorili okvir za dijalog Preferences. U spisku Category iza-

berite Code Format. Zatim iz menija Line Break Type izaberite opciju CR LF 

(Windows).

 

U meniju Line Break Type imate opcije CR LF (Windows), CR (Macintosh) 

i LF (Unix).

U Windowsu je podrazumevana vrednost CR LF (Windows).

Na Macintoshu je podrazumevana vrednost CR (Macintosh).

Ako je datoteka koju uvozite napravàena u Windowsu, izaberite opciju CR LF 

(Windows), a ako je napravàena na Macintoshu, izaberite opciju CR (Macintosh.

 

2)  

 

Pritisnite OK.

 

Okvir za dijalog Preferences se zatvara.

kategorija code format u okviru za dijalog preferences
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Tekst u Dreamweaver moæete uvesti i tako ãto ñete otvoriti dokument iz 
Microsoft Worda koji je snimàen kao tekstualna datoteka (.txt) ili kao HTML datoteka. 
Da biste Wordov dokument snimili kao HTML datoteku, otvorite ga u Wordu i odaberite 
File > Save as Web Page. Postoje razni problemi prilikom uvoæeça HTML-a koji pravi 
Microsoft Word. O çima i o çihovim reãeçima govorimo u lekciji 14.

 

UVOÆEÇE TEKSTA

 

Poãto ste zadali parametar za prelom reda moæete uvesti tekst.

 

U ovoj veæbi koristiñemo dokument koji je napravàen u Windowsu. 
U prethodnoj veæbi podesili ste parametar Line Break Type za rad sa Windowsovim tipom 
prelamaça. U direktorijumu Starting Files pronañi ñete joã jedan dokument, intro_mac.txt 
(napravàen na Macintosh raåunaru), da biste mogli da veæbate uvoæeçe tekstualnih dato-
teka sa razliåitih platformi. Ako odluåite sami da ekperimentiãete s tom datotekom, ne zabo-
ravite da treba da podesite parametar Line Break Type: umesto CR LF (Windows) 
odaberite CR (Macintosh) pre nego ãto otvorite ili uvezete datoteku.

 

1)  

 

U Dreamweaveru otvorite datoteku Lesson_

 

02

 

_Content\Text\introduction.txt, 

zatim izaberite i kopirajte ceo tekst. U datoteci introduction.htm postavite kursor 

u novi red pasusa koji ste ranije napravili ispod naslova “Introduction to Lights of 

the Coast: Exploring Lighthouses” i prenesite kopirani tekst.

 

Za kopiraçe i prenoãeçe teksta moæete koristiti meni Edit (izaberite opciju 

menija Edit > Copy i/ili Edit > Paste), kao i uobiåajene preåice s tastature: Ctrl+C 

(Windows), odnosno Command+C (Macintosh) za kopiraçe, i Ctrl+V (Windows), 

odnosno Command+V (Macintosh) za prenoãeçe.

 

Korisnici Windowsa:

 

 Prozor dokumenta automatski zauzima åitav raspoloæivi 

prostor, a za svaki otvoreni dokument prikazani su jeziåci. Sa jednog dokumenta 

na drugi moæete preñi tako ãto ñete pritisnuti odgovarajuñi jeziåak. Ako jeziåak 

pritisnete desnim tasterom miãa doñi ñete do opcije za zatvaraçe datoteke. Da 

biste umesto prikaza s jeziåcima preãli na prikaz plutajuñih prozora, pritisnite 

dugme za maksimiraçe u gorçem desnom uglu prozora dokumenta (nemojte 

pritisnuti dugme za maksimiraçe prozora celog programa). Ponovo pritisnite isto 

dugme da biste vratili prikaz sa jeziåcima. Ove opcije ne postoje na Macintoshu.

n a p o m e n a

n a p o m e n a

jeziåci u prozoru dokumenta

dugme za maksimiraçe/vrañaçe na prethodnu veliåinu
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2)  

 

Snimite datoteku introduction.htm i zatvorite datoteku introduction.txt.

 

Neka datoteka introduction.htm ostane otvorena jer ñete je koristiti u sledeñoj 

veæbi.

 

UBACIVAÇE NELOMIVOG RAZMAKA

 

HTML prepoznaje samo jedan standardan razmak. Za viãe razmaka koristi se 

poseban znak za nelomiv razmak (engl. 

 

non-breaking space

 

). Taj znak ñete koristiti 

kada izmeœu znakova, reåi ili drugih elemenata æelite da ubacite viãe razmaka. 

Moæete ga postaviti i na poåetak reda teksta, jer red inaåe ne moæete poåeti stan-

dardnim razmakom.

 

1)  

 

U datoteci introduction.htm postavite kursor izmeœu reåi “Exploring” i 

“Lighthouses” na vrhu dokumenta.

 

Ove reåi se neñe dodatno razdvojiti ako viãe puta pritisnete razmaknicu – izmeœu 

çih ñe ostati samo jedan razmak.

 

2)  

 

Pritisnite dvaput Ctrl+Shift+razmaknica (Windows), odnosno Option+raz-

maknica (Macintosh).

 

Nelomivi razmak moæete ubaciti i tako ãto ñete odabrati Insert > HTML > 
Special Characters > Non-Breaking Space ili tako ãto ñete u kategoriji Text trake Insert 
pritisnuti ikonicu menija Characters, pa odabrati opciju Non-Breaking Space.

 

Rastojaçe izmeœu reåi poveñava se svaki put kada ubacite nelomiv razmak.

 

Prepoznavaçe viãe razmaka moæete omoguñiti meçaçem parame-
tara programa. Odaberite Edit > Preferences (Windows), odnosno Dreamweaver > Prefer-
ences (Macintosh) i izaberite kategoriju General. Potvrdite poàe Allow multiple consecutive 
spaces. Kada je ova opcija ukàuåena, Dreamweaver ñe uvek postavàati nelomivi razmak 
kada viãe puta pritisnete razmaknicu.

 

PORAVNAVAÇE I UVLAÅEÇE TEKSTA

 

Opcije poravnaça teksta su podrazumevani izgled (bez poravnaça), poravnaçe 

ulevo (engl. 

 

align left

 

), centriraçe (engl. 

 

align center

 

), poravnaçe udesno (engl. 

 

align right

 

) i obostrano poravnaçe (engl. 

 

justify

 

). Podrazumevano poravnaçe je 

isto ãto i poravnaçe ulevo.

s a v e t 1

n a p o m e n a
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1)  

 

U datoteci introduction.htm, postavite kursor u naslov “Introduction to Lights 

of the Coast”. Pritisnite dugme Align Center na panou Properties. 

 

Naslov je centriran. Poãto ste umetnuli znak za prelazak u novi red izmeœu 

“Introduction to Lights of the Coast” i “Exploring Lighthouses”, sada su centri-

rana oba reda teksta. Poãto su razdvojeni znakom za prelazak u novi red, oba reda 

su deo istog pasusa, pa ñe sva formatiraça pasusa koja primenite na blok teksta, 

npr. poravnaçe ili zadavaçe nivoa naslova, uticati na celokupan sadræaj pasusa.

 

2)  

 

Izaberite prvi pasus teksta u datoteci introduction.htm i pritisnite dugme 

Text Indent na panou Properties.

 

Za uvlaåeçe izabranog teksta od margina moæete da upotrebite i opciju 
menija Text > Indent.

 

Pasus je sada uvuåen. Uvlaåeçe teksta se primeçuje na ceo pasus – ne moæete 

uvuñi samo prvi red osim ako koristite kaskadne opise stilova (o kojima govori 

lekcija 6). Razliåitim uvlaåeçem teksta izdvajate delove teksta. Alatkom Text 

Indent tekst se uvlaåi u odnosu na obe margine, i levu i desnu. Veliåinu tog uvla-

åeça ne moæete da zadate, jer se ona meça u zavisnosti od åitaåa Weba koji prika-

zuje tekst.

Pasus moæete viãe puta uvuñi. Leva i desna margina ñe svaki put kada uvuåete 

blok teksta biti uveñane. To ñete åiniti da biste joã malo uvukli pasus u odnosu na 

prethodno uvuåene pasuse, ili da bi uvuåeni pasus postao uoåàiviji.

Tekst viãe neñe biti uvuåen kad pritisnete dugme Text Outdent na panou Pro-

perties ili izaberete opciju menija Text > Outdent.

align left (levo poravnaçe) justify (obostrano poravnaçe)
align center (centriraçe) align right (desno poravnaçe)

opcije poravnaça teksta na panou properties

s a v e t 1

opcije za uvlaåeçe teksta �
na panou properties

izvlaåeçe teksta uvlaåeçe teksta
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Ako pri uvlaåeçu jednog pasusa, uvuåete viãe susednih pasusa, prove-
rite da li su umesto znaka za prelazak u novi pasus upotrebàena dva uzastopna znaka 
za prelazak u novi red. Postavite kursor na poåetak pasusa koji hoñete da uvuåete. Zatim 
pritiskajte Backspace (Windows), odnosno Delete (Macintosh), sve dok ne doœete do kraja 
prethodnog pasusa i potom pritisnite Enter (Windows), odnosno Return (Macintosh), 
kako biste zaista zavrãili prethodni pasus i preãli u novi.

 

PRAVÀEÇE SPISKOVA

 

Dreamweaver omoguñava pravàeçe tri vrste spiskova (lista): ureœenih, neureœe-

nih i lista definicija. 

 

Ureœena lista

  

    

 

(engl. 

 

ordered list

 

) sadræi stavke odvojene rednim 

brojevima ili slovima abecede, i poreœane u numerisani, odnosno abecedni spi-

sak. Moæete da koristite arapske ili rimske brojeve, odnosno velika ili mala slova 

abecede. Ureœene liste su odliåan izbor kada treba jasno da organizujete 

i oznaåite stavke, na primer, u spisku koraka nekog postupka. 

 

Neureœena lista

 

 

 

(engl. 

 

unordered list

 

) åesto se naziva 

 

lista nabrajaça

 

, jer svaka stavka u çoj poåiçe 

znakom za nabrajaçe (bulitom). Podrazumevani znak za nabrajaçe koji Dream-

weaver prikazuje moæe biti zameçen punim krugom, kruænicom ili kvadratom. 

Neureœene liste su dobre za prikazivaçe informacija åija svaka stavka treba da 

bude razdvojena, ali gde nije neophodno numerisaçe, na primer, u spisku vrsta 

hrane. 

 

Liste definicija

 

 (engl. 

 

definition list

 

) saåiçene su od termina i çihovih defi-

nicija; one ñe biti objaãçene u narednoj veæbi.

U sva tri tipa spiskova stavke moraju biti postavàene u poseban pasus da bi 

lista bila ispravno formatirana.

U ovoj veæbi napraviñete dve liste: ureœenu i neureœenu. Zatim ñete izmeniti 

stil tih lista pomoñu okvira za dijalog List Properties. (Sa listom definicija radiñete 

kasnije u ovoj lekciji.)

 

1)  

 

U datoteci introduction.htm izaberite tekst koji poåiçe sa “Guiding ships into 

port” i zavrãava se sa “Serving as identifying markers of a particular region.” 

Pritisnite dugme Ordered List na panou Properties.

 

Izabrani tekst se uvlaåi od margina i pretvara u numerisan spisak.

Ãemu numerisaça ureœene liste promeniñete izmenom çenih svojstava. 

To ñete uraditi u sledeñem koraku.

n a p o m e n a

opcije lista na �
panou properties

neureœena lista ureœena lista
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2)  

 

Pritisnite bilo koji red spiska. Zatim pritisnite dugme List Item na panou 

Properties.

 

Izaberite samo jedan red liste. Ukoliko izaberete celu listu, dugme List Item 

postañe nedostupno i sivo. Ako se dugme ne vidi, pritisnite strelicu za proãireçe 

u doçem desnom uglu panoa Properties.

Otvoriñe se okvir za dijalog List Properties. 

 

Isti okvir za dijalog List Properties moæete da otvorite i pomoñu opcije 
menija Text > List > Properties, ako je kursor u listi.

 

Ureœena lista se u meniju List type naziva Numbered List.

 

3)  

 

Iz menija Style izaberite opciju Alphabet Small (a,b,c). Zatim pritisnite OK.

 

Alphabet Small se prikazuje kao opcija u meniju Style samo ako ste 
pritisnuli dugme Ordered List. Ako ste pritisnuli dugme Unordered List, pre biraça stila 
morate da izaberete opciju Numbered List u meniju List type. 

 

Redni brojevi liste pretvoreni su u mala slova abecede.

 

Podruåje List item na dnu okvira za dijalog List Properties sadræi 
meni New style, pomoñu kojeg meçate izgled pojedine stavke ili grupe stavki spiska, ume-
sto celog spiska. U istom podruåju je i poàe Reset count to, koje sluæi za proizvoàno zada-
vaçe rednog broja stavke u kojoj se nalazi kursor; sve naredne stavke automatski 
dobijaju sledeñe redne brojeve.

 

Sledi opis postupka izrade i modifikovaça neureœene liste.

s a v e t 1
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4)  

 

Izaberite sledeña dva reda teksta: “The importance of lighthouses through-

out history and the roles that they’ve played” i “The technological advances 

that brought the lighthouse into its golden age”. Pritisnite dugme Unordered 

List na panou Properties.

 

Za pretvaraçe izabranog teksta u neureœenu listu sluæi i opcija menija 
Text > List > Unordered List.

 

Izabrani tekst ñe biti uvuåen i dobiñe znakove za nabrajaçe.

Podrazumevani znak za nabrajaçe neureœenih lista moæete da promenite 

izmenom odgovarajuñih svojstava, isto kao kod ureœenih lista. Izgled znaka za 

nabrajaçe kao i rastojaça izmeœu stavki razlikovañe se u zavisnosti od åitaåa 

Weba. Moguñnost kontrolisaça izgleda brojeva (ili slova), znakova za nabrajaçe 

i razmaka izmeœu stavki ograniåene su – da biste imali viãe slobode moæete kori-

stiti opise stilova, o kojima govorimo u lekciji 6.

U meniju List type (u okviru za dijalog List Properties koji ste koristili u pret-

hodnom koraku), neureœena lista se naziva Bulleted List.

 

Da biste uklonili formatiraçe liste, odaberite celu listu i pritisnite odgovara-
juñe dugme na panou Properties (ikonicu Ordered List ukoliko je u pitaçu ureœena lista 
ili ikonicu Unordered list ako je u pitaçu neureœena lista), ili ikonicu drugog tipa liste da 
biste zadali taj tip.

 

5)  

 

Postavite kursor na kraj posledçeg reda liste nabrajaça, pa pritisnite Enter 

(Windows), odnosno Return (Macintosh). Unesite tekst 

 

The influence light-

houses have had on human culture

 

.

 

Kada listi dodajete tekst morate ga uneti kao pasus da biste napravili nov blok 

teksta koji ñe biti nova stavka liste. Svaka stavka u listi mora biti u posebnom 

pasusu.

 

Kada dvaput pritisnete Enter, odnosno Return, izañi ñete iz reæima za rad 
s listama i dobiti podrazumevani pasus. Ako treba da napravite jedan, ili viãe novih 
redova u okviru iste stavke liste, koristite opciju za prelamaçe reda.

 

6)  

 

Pritisnite bilo koji red u listi nabrajaça i izaberite opciju menija Text › List › 

Properties.

 

Otvoriñe se okvir za dijalog List Properties.

s a v e t 1

s a v e t 1
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Meni List type okvira za dijalog List Properties sadræi joã dva tipa 
lista: Menu i Directory. To su starije verzije liste nabrajaça. Obe imaju svrhu sliånu 
neureœenim listama i u veñini åitaåa Weba izgledaju isto kao neureœene liste. Preporu-
åujemo da za sve neureœene liste koristite opciju Bulleted list.

 

7)  

 

Iz menija Style izaberite opciju Square i pritisnite OK.

 

Obavezno koristite meni Style – ne meni New style. Ako opciju odaberete u 
meniju New style u podruåju List item, izmene ñe biti primeçene samo na red liste u kome 
se nalazi kursor.

 

Sve stavke u listi dobiñe kvadrat (engl. 

 

square

 

) kao znak za nabrajaçe.

 

Boja rednih brojeva i znakova za nabrajaçe, koji se koriste u ureœe-
nim i neureœenim listama, jednaka je podrazumevanoj boji teksta dokumenta. Podrazu-
mevane parametre dokumenta zadañete kasnije u ovoj lekciji.

 

PRAVÀEÇE LISTE DEFINICIJA

 

Lista definicija

 

 

 

sadræi niz termina i çihovih definicija. Reå ili termin koji se defi-

niãe poravnat je ulevo; definicija je uvuåena od margina i smeãtena u sledeñi red. 

U ovakvim listama nema znakova za usmeravaçe koji postoje u ureœenim i 

neureœenim listama.

 

1)  

 

U datoteci introduction.htm izaberite tekst koji poåiçe sa “Light Source” 

i zavrãava sa “associated with the operation and maintenance of lighthouses”. 

Izaberite Text › List › Definition List.

 

Termini su sada poreœani uz levu marginu, a çihove uvuåene definicije smeãtene 

su u redove ispod çih.

n a p o m e n a
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Lista bi trebalo da izgleda kao primer na sledeñoj slici.

 

2)  

 

Snimite datoteku i pregledajte je u åitaåu.

 

Poãto ste uloæili trud u pravàeçe i formatiraçe svih tih lista, snimite dokument.

 

UGNEÆŒIVAÇE LISTA

 

Liste se mogu 

 

ugnezditi

 

, odnosno stavàati unutar drugih lista. Ugneæœena lista 

moæe biti istog tipa kao roditeàska ili razliåitog tipa. Na primer, ureœena lista moæe 

biti postavàena unutar liste definicija. Kada ugneæœujete liste, podrazumevano se 

koriste puni krugovi, kruænice i kvadrati (tim redom) kao znakovi za nabrajaçe. 

U Dreamweaveru se ti znakovi za nabrajaçe nazivaju 

 

bullet, circle i square. Odgova-

rajuñi termini u HTML-u su disc, circle i square.
Neki åitaåi prikazuju ãupàe kvadrate kao znakove za nabrajaçe. Takav je, na 

primer, Netscape 4.7 za Macintosh. Internet Explorer 5.0 za Macintosh prikazuje 

ispuçene kvadrate. U Windowsu su kvadrati ispuçeni.

1)  U datoteci introduction.htm dodajte novu stavku listi nabrajaça: dovedite 

kursor na kraj reda “The technological advances that brought the lighthouse 

into its golden age” i pritisnite Enter (Windows), odnosno Return (Macintosh).

Time ste dodali novu stavku posle tog reda, na istom nivou.

2)  Da biste ugnezdili stavku koju ñete napraviti, pritisnite dugme Text Indent na 

panou Properties. Upiãite Incandescent oil vapor lamp.
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Stavka ñe biti uvuåena na sledeñi nivo. Kada ugnezdite listu, znakovi nabrajaça u 

toj listi razlikovañe se po stilu od onih u glavnoj listi. U ovom primeru, ugneæœena 

lista koristi otvorene krugove. Stil znakova moæete promeniti u okviru za dijalog 

List Properties kao ãto ste ranije åinili za glavnu listu.

Ugneæœena lista bi trebalo da izgleda kao primer na sledeñoj slici.

 Da biste stavku iz ugneæœene liste pretvorili u stavku glavne liste, 
postavite kursor u çu, ali nemojte je izabrati. Pritisnite dugme Text Outdent na panou 
Properties.

3)  Upiãite sledeñe reåi kao stavke ugneæœene liste: Argand lamp, Fresnel lens, 

Screwpile construction i Electricity.

Kao i pri uvlaåeçu teksta, ne moæete da kontroliãete niti da podeãavate prored 

izvuåenih objekata, lista ili ugneæœenih lista.

Ako se izmeœu posledçe stavke ugneæœene liste i sledeñe stavke glavne liste 
pojavi dodatan red, postavite kursor u çega i pritisnite Backspace (Windows), odnosno 
Delete (Macintosh). Moæe se desiti da posledçi znak u posledçem redu ugneæœene liste 
bude obrisan, pa ga ponovo upiãite.

FORMATIRAÇE ZNAKOVA
Da biste istakli odreœene stavove, reåi ili izraze, Dreamweaver vam omoguñava 

da na tekst primenite viãe opcija formatiraça – to su polucrni (podebàan) ispis 

(engl. bold), kurzivni ispis (engl. italic) i podvlaåeçe (engl. underline) teksta. 

n a p o m e n a

s a v e t 1
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1)  U datoteci introduction.htm izaberite reåi “Light Source” u listi definicija.

Ispisañete izabrani tekst polucrnim (engl. bold ) slovima.

2)  Pritisnite dugme Bold na panou Properties.

Za ispisivaçe izabranog teksta polucrnim slovima moæete da upotrebite i opciju 

menija Text > Style > Bold ili da pritisnete dugme Bold u kategoriji Text trake 

Insert. Odgovarajuñe preåice s tastature su Ctrl+B (Windows), odnosno Com-

mand+B (Macintosh).

Kada za ispisivaçe polucrnim slovima koristite pano Properties, 
Dreamweaver oko izabranog teksta postavàa HTML oznake <strong> i </strong> 
(engl. strong – jako). Sliåno tome, kada tekst ispisujete kao kurziv, Dreamweaver pre i 
posle izabranog teksta postavàa oznake <em> i    </em>    (od engl. emphasis – akcenat). Ove 
oznake se nazivaju i logiåke jer na sadræaj utiåu i konceptualno i vizuelno, za razliku od 
oznaka bold za polucrne znakove i italic za kurzivne znakove (<b>, <i>) koje nazivamo 
fiziåkim oznakama jer utiåu samo na izgled teksta. Logiåke oznake su fleksibilnije i dostup-
nije ãiroj publici.

Na isti naåin ispisañete tekst kurzivom.

Izbegavajte podvlaåeçe teksta na Web stranama, jer se tako najåeãñe oznaåa-
vaju hiperveze, pa ñete podvlaåeçem teksta koji nije hiperveza moæda zbuniti posetioce. 

3)  I ostale termine u listi definicija ispiãite polucrnim slovima.

Åesto ñete posledçu akciju, kao ãto je formatiraçe, ponavàati na sledeñim pasu-

sima ili drugom izabranom tekstu. Naredba Redo svodi operaciju na jedan priti-

sak tastera. Prve dve stavke u meniju Edit jesu naredbe Undo i Redo. Zapamtite 

çihove preåice s tastature:

Undo: Ctrl+Z (Windows), odnosno Command+Z (Macintosh)

Redo: Ctrl+Y (Windows), odnosno Command+Y (Macintosh)

Pano History moæete koristiti da biste ubrzali izvoœeçe akcija koje se åesto 

ponavàaju. Izaberite niz akcija sa panoa i pritisnite dugme Save selected steps as 

command, koje se nalazi u doçem desnom uglu panoa, ili odaberite stavku Save 

n a p o m e n a

alatke za formatiraçe znakova na panou properties

bold (polucrna slova) italic (kurzivna slova)

s a v e t 1
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As Command iz kontekstnog menija u gorçem desnom uglu panoa. Ako hoñete 

brzo da ubacujete delove koda koje åesto koristite, iskoristite pano Snippets 

(o çemu govori lekcija 14).

U Dreamweaveru postoji greãka zbog koje komandom Redo neñete 
moñi ponovo da primenite ispisivaçe teksta polucrnim ili kurzivnim znakovima. Zbog 
toga nastavite da koristite pano Properties ili preåice s tastature Ctrl+B (Windows), 
odnosno Command+B (Macintosh) da biste formatirali preostale termine. Ova greãka se 
odnosi i na akcije Bold i Italic na panou History. Moæda ñete morati da ponavàate 
komandu Undo sve dok ne uklonite kôd nastao zadavaçem komande Redo za pona-
vàaçe formatiraça polucrnog i kurzivnog teksta. Kada komandom Redo pokuãate da 
ponovite zadavaçe polucrnog teksta, nastañe kôd <span body="bold"> i </span>. 
Kada komandom Redo pokuãate da ponovite formatiraçe teksta kao kurzivnog, nastaje 
kôd <span mm:togglevisibility="italic"> i </span>. Te oznake su neispravne 
i treba da ih uklonite iz dokumenta. Za brisaçe ovih oznaka moæete koristiti komandu 
Undo ili ih sami obrisati iz koda strane. U lekciji 14 nauåiñete kako da radite s kodom.

PROMENA FONTA
Web strane ñe biti zanimàivije i lakãe ñe se åitati ako meçate fontove kojim se 

prikazuje tekst. Premda se o koriãñeçu razliåitih slova u ãtamparstvu mnogo zna, 

sve to ne vaæi i na Webu.

Beserifni fontovi se na ekranima monitora po pravilu åitaju lakãe od serifnih 

fontova. Serifni fontovi se obiåno koriste u ãtampi jer serifi (“kukice” na kraje-

vima linija znakova) olakãavaju prañeçe znakova. Meœutim, na monitoru serifi 

oteæavaju raspoznavaçe oblika znakova, naroåito kada se åitaju veñe koliåine tek-

sta ili kada su slova mala. Bitno je da imate na umu i åiçenicu da tok teksta na 

strani moæe biti razliåit kod korisnika.

Dreamweaver za definisaçe opcija fonta koristi integrisane kaskadne opise sti-

lova, umesto starije metode koriãñeça atributa HTML oznaka za font. O kaskad-

nim opisima stilova detaànije govori lekcija 6.

Font cele strane ili izabranog dela teksta moæete meçati, kao ãto ñete videti u 

sledeñoj veæbi.

1)  Dok je datoteka introduction.htm otvorena, odaberite Modify › Page Proper-

ties i odaberite stavku Appearance s liste Category. Iz menija Page font izaberite 

opciju Arial, Helvetica, sans-serif. Pritisnite OK da biste zatvorili okvir za dijalog 

Page Properties.

n a p o m e n a



DODAVAÇE SADRÆAJA WEB STRANI 55

DW04, May 6, 2004 9:50 am

Sav tekst na strani biñe ispisan odabranim fontom: Arial, Helvetica, sans-serif. 

Ukoliko strani kasnije dodate joã teksta, i on ñe biti ispisan istim fontom.

Okvir za dijalog Page Properties generiãe interni opis stila za ponovno 
definisaçe skupa oznaka (body, td, th) sa odabranim osobinama fonta. Interni stilovi su 
opisani u lekciji 6.

Kombinacije instaliranih fontova koje su nabrojane u meniju Page font kate-

gorije Appearance govore åitaåu da tekst ispiãe fontom iz te grupe, u zavisnosti od 

instaliranih fontova na raåunaru posetioca. Ukoliko prvi font u grupi fontova nije 

instaliran, åitaå ñe pokuãati da upotrebi drugi, a na kraju i treñi. Ako nijednog od 

tih fontova nema na korisnikovom raåunaru, tekst se prikazuje podrazumevanim 

fontom åitaåa Weba. 

2)  Izaberite tekst “Introduction to Light of the Coast: Exploring Lighthouses” na 

vrhu strane. Iz menija Font na panou Properties odaberite opciju Times New 

Roman, Times, serif.

Font koji ste odabrali za naslov zameniñe font koji ste zadali kao podrazumevani 

font strane. Kombinacije fontova koje moæete odabrati u meniju Font na panou 

Properties, iste su kao kombinacije dostupne u meniju Page Font u kategoriji 

Appearance okvira za dijalog Page Properties.

opcija arial, helvetica, sans-serif izabrana u meniju �
page font u okviru za dijalog page properties meni page font

n a p o m e n a
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Na izabrani tekst u prozoru dokumenta direktno moæete primeniti viãe 
opcija formatiraça tako ãto ñete tekst pritisnuti desnim tasterom miãa (Windows i Macin-
tosh), odnosno dræati pritisnut taster Control i pritisnuti miãem s jednim tasterom (Mac-
intosh) da biste otvorili kontekstni meni.

Da bi posetilac prezentacije tekst video ispisan fontom koji ste odabrali, taj 

font mora biti instaliran na çegovom raåunaru. Nemojte pretpostavàati da su 

svi fontovi koje imate uåitani na svaåiji raåunar. Fontovi koji nisu ukàuåeni u 

osnovni operativni sistem, moæda se uopãte ne nalaze na raåunaru posetioca. 

Pored toga, dostupnost fontova nije ista u Windowsu i na Macintoshu. Fontovi 

navedeni u Dreamweaverovim podrazumevanim skupovim fontova obiåno su 

dostupni na veñini raåunara, na obe platforme.

Ako hoñete da koristite neki poseban font, koji verovatno nije instaliran na 
raåunarima posetilaca, preporuåujemo da umesto teksta koristite sliku. Ova tehnika se åesto 
koristi za zaglavàa, naslove itd. Slike se ne preporuåuju kao zamena za dugaåke tekstove. 

Kombinacije fontova (kao ãto je Arial, Helvetica, sans-serif) jesu korisne, ali ne 

obuhvataju uvek baã one fontove koje ste hteli da upotrebite. Kombinaciju fon-

tova moæete da promenite kada izaberete opciju Edit Font List u padajuñoj listi 

Font na panou Properties, odnosno kada pomoñu opcije menija Text > Font > 

Edit Font List otvorite okvir za dijalog Edit Font List.

meni font
kombinacija fontova times new roman, times, serif �
izabrana u meniju font na panou properties

n a p o m e n a
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U okviru za dijalog Edit Font List moæete izmeniti skupove fontova:

• Da biste postojeñoj kombinaciji dodali font: u listi Font list (lista fontova) 

izaberite kombinaciju koju hoñete da izmenite, a u listi Available fonts 

(dostupni fontovi) izaberite font koji hoñete da dodate; pritisnite dugme sa 

strelicom ulevo izmeœu liste Chosen fonts i liste Available fonts da biste 

font dodali listi Chosen fonts (odabrani fontovi).

• Da biste iz postojeñe kombinacije izbacili font: izaberite kombinaciju koju 

hoñete da izmenite i font koji hoñete da uklonite sa liste Chosen fonts; 

pritisnite dugme sa strelicom udesno izmeœu liste Chosen fonts i Available 

fonts da biste font uklonili sa liste Chosen fonts.

• Da biste dodali kombinaciju fontova:    sa liste Font list odaberite opciju Add 

fonts in list below. Za dodatne kombinacije fontova pritisnite dugme sa zna-

kom plus u gorçem levom uglu okvira za dijalog, pa ponovo odaberite 

opciju Add fonts in list below.

• Da biste uklonili kombinaciju fontova:    sa liste Font list izaberite kombina-

ciju koju hoñete da uklonite i pritisnite dugme sa znakom minus u gorçem 

levom uglu okvira za dijalog.

• Da biste dodali font koji nije instaliran na sistemu: upiãite ime fonta u poàe 

ispod liste Available fonts i pritisnite dugme sa strelicom; time ñete izabrani 

font dodati kombinaciji. Dodavaçe fonta koji nije instaliran na sistemu je 

korisno; na primer, moæete zadati odreœen Windowsov font kada radite na 

Macintoshu. Vodite raåuna da pravilno napiãete ime fonta.

• Da biste promenili redosled kombinacija fontova:    izaberite kombinaciju 

fontova i pritiskajte dugmad sa trougliñima okrenutim nagore i nadole u 

gorçem desnom uglu okvira za dijalog.

Lista Available fonts u okviru za dijalog Edit Font List sadræi fontove koji su 

instalirani na vaãem raåunaru.

3)  Snimite datoteku i pogledajte stranu u åitaåu.

Tekst ñe se sada prikazati u fontovima izabranim u åitaåu, u zavisnosti od fontova 

koji su instalirani na raåunaru.

Moæete da uklonite podeãene parametre fontova i vratite podrazumevani 
font: najpre izaberite tekst ispisan fontom koji hoñete da uklonite, a potom izaberite opciju 
Default Font u padajuñoj listi Font na panou Properties. Drugi naåin je da izaberete 
opciju menija Text > Font > Default Font.

PROMENA VELIÅINE FONTA
U HTML-u su opcije za meçaçe veliåine fonta ograniåene. Veliåina teksta je 

zadata kao atribut oznake <font> (dela HTML koda koji definiãe svojstva teksta) 

i zasnovan je na sistemu relativnih i apsolutnih veliåina. Ako ste radili na pripremi 

ãtampanog materijala (kao ãto su åasopisi i broãure), zasmetañe vam nedostatak 

s a v e t 1
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tipografske kontrole. Atributi fonta u HTML-u omoguñavaju samo minimum 

kontrole nad izgledom teksta, dok koriãñeçe kaskadnih opisa stilova Web dizaj-

nerima omoguñava mnogo precizniju izradu strana sa tekstom.

Zastareli atributi HTML oznake <font>, ukàuåujuñi veliåinu znakova, viãe 

nisu dostupni u Dreamweaveru. Umesto çih, postoji veliki izbor unapred defi-

nisanih vrednosti za veliåinu, ukàuåujuñi numeriåke vrednosti u intervalu od 9 

do 36, relativne vrednosti od xx-small (ekstra ekstra malo) do xx-large (ekstra 

ekstra veliko) i opcije za maçe (engl. smaller) i veñe (engl. larger). Sve te opcije za 

definisaçe veliåine teksta koriste kaskadne opise stilova. U Dreamweaveru 

pomoñu integrisanih funkcija opisa stilova moæete postiñi veoma dobru kontrolu 

teksta na Web stranama. O kaskadnim opisima stilova uåiñete u lekciji 6.

Veliåine fontova se veoma razlikuju na Macintoshu i u Windowsu. 
Macintosh raåunari prikazuju otprilike 25% sitniji tekst od Windowsa – veliåina teksta 
na Macintoshu iznosi tri åetvrtine veliåine u Windowsu. I korisnici mogu meçati veliåinu 
fonta ãto moæe uticati na dizajn strane. Zato testirajte svoje Web strane imajuñi u vidu 
potencijalne varijacije da biste napravili prilagodàivu Web prezentaciju koja ñe na raåu-
narima veñine posetilaca funkcionisati kako treba.

Izaberite prvi uvuåeni pasus blizu vrha strane. Iz menija Size na panou Proper-

ties izaberite 12. Ostavite podrazumevanu mernu jedinicu: pixels (pikseli).

Veliåina teksta u pasusu neznatno ñe se smaçiti i izgledañe maçe od ostatka 

teksta na strani åija veliåina nije formatirana. Svaki put kada odaberete veliåinu 

koja se dotad nije koristila na Web strani, Dreamweaver ñe napraviti nov stil koji 

ñe biti naveden u meniju Style na panou Properties. Svaki sledeñi tekst kom 

bude dodeàena ista veliåina koristiñe isti stil. Ti stilovi imaju opãta imena koja se 

generiãu automatski numeriåkim redosledom: style1, style2 itd. Novi stilovi se 

prave za svaku jedinstvenu kombinaciju fonta, çegove veliåine i boje.

U odeàku Appearance okvira za dijalog Page Properties moæete zadati i 
podrazumevanu veliåinu teksta za dokument.

Ako nijedna veliåina nije zadata za izabrani tekst, u menijima Size i Style sta-

jañe “None”. Tekst bez definisane veliåine u åitaåu ñe biti prikazan u podrazu-

mevanoj veliåini koja je jednaka vrednosti 14 u meniju Size (mada se moæe 

razlikovati u zavisnosti od parametara koje je korisnik zadao).

n a p o m e n a
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Zadatu veliåinu fonta moæete ukloniti i vratiti podrazumevanu vrednost 
tako ãto ñete prvo izabrati tekst koji ñete meçati, a potom odabrati opciju None iz menija 
Style ili odabrati Text > CSS Styles > None.

Vrednost ne moæete uneti u meni Size – morate odabrati jednu od postojeñih. 

Ako hoñete da koristite i neke druge vrednosti, pored ponuœenih, morate napra-

viti dodatne stilove teksta ãto ñete lako uåiniti direktno preko menija Styles. 

U lekciji 6 uåiñete kako se prave dodatni stilovi i kako se radi sa kaskadnim 

opisima stilova.

Numeriåke opcije veliåine fonta koje su dostupne u meniju Size verovatno su 

vam poznate jer su sliåne standardnim veliåinama koje viœate u programima za 

obradu teksta.

Sledeña tabela poredi vrednosti koje su sada dostupne u meniju Size sa stan-

dardnim opcijama za veliåinu HTML oznake <font>.

* Sa podrazumevanom mernom jedinicom, pikselima
** Ova numeriåka vrednost neãto je veña od vrednosti x-large (6), a neãto maça od 

xx-large (7)

HTML oznaka <font> definiãe veliåinu teksta kao apsolutnu (od 1 do 
7) ili kao relativnu (od +1 do +7 i od -1 do -7). Ako izaberete apsolutan broj (1 je naj-
maçi font, a 7 najveñi), zadali ste veliåinu fonta. Podrazumevana osnovna veliåina fonta 
u åitaåu je 3. Ako izaberete pozitivan ili negativan broj, veliåina fonta ñe biti relativna u 
odnosu na tu osnovnu veliåinu. Na primer, veliåina +1 za jedan broj je veña od osnovne 

POREŒEÇE VELIÅINE TEKSTA: HTML I CSS

Relativne 
veliåine teksta 
u HTML-u

Apsolutne 
veliåine teksta 
u HTML-u

Numeriåke 
vrednosti* u meniju 
Size (zasnovane na 
CSS-u)

Relativne 
vrednosti u meniju 
Size (zasnovane na 
CSS-u)

9

-2 1 10 xx-small

-1 2 12 x-small/smaller

None 

(podrazumevano)

3 14 small

+1 4 18 medium/larger

+2 5 24 large

+3 6 x-large

36**

+4 7 xx-large

s a v e t 1
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veliåine. Ako za veliåinu fonta odaberete +3, zapravo ñete zadati 6 (3+3). Najveña veliåina 
fonta je 7, a najmaça 1. Svaki font koji je u HTML-u veñi od 7 prikazuje se veliåinom 7; 
primera radi, ako izaberete veliåinu fonta +6, 3+6 je veñe od 7, ali ñe se ipak prikazati font 
veliåine 7. Ova ograniåeça HTML oznake <font> ne utiåu na opise stilova koji nude 
mnogo prilagodàiviji i svestraniji naåin za definisaçe svojstava teksta.

ZADAVAÇE BOJE SLOVA
Kada promenite pozadinsku boju strane, kao ãto ste uåinili u prethodnoj lekciji, 

moæda ñete morati da promenite i boju teksta da biste izbegli probleme sa prika-

zom. Na primer, crn tekst neñe biti prikazan na crnoj pozadini. Pri biraçu ãeme 

boja za dokument, pokuãajte da odaberete kombinacije boja koje zajedno funkci-

oniãu kako treba i izmeœu kojih postoji dovoàna razlika u kontrastu. Boje koje su 

previãe sliåne veoma se teãko pregledaju, a isto vaæi i za komplementarne boje – 

naroåito na ekranu monitora. U sledeñoj veæbi promeniñete podrazumevanu boju 

fonta u dokumentu introduction.htm.

1)  Odaberite Modify › Page Properties, pa izaberite stavku Appearance s liste 

Category.

Otvoriñe se okvir za dijalog Page Properties sa viãe opcija koje omoguñavaju da 

podesite razne parametre dokumenta.

2)  Pritisnite poàe sa uzorkom boje uz opciju Text color.

Pojaviñe se paleta boja, sliåna onoj koju ste koristili za biraçe boje pozadine u 

prethodnoj lekciji.

3)  Odaberite crvenocrnu boju sa heksadecimalnom vrednoãñu #330000 i priti-

snite OK.

ekran appearance okvira za dijalog page properties u �
kom se vide uzorci boja nameçenih koriãñeçu na webu
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Boju moæete odabrati tako ãto ñete u tekstualno poàe uneti heksadecimalnu 

vrednost ili tako ãto ñete je odabrati meœu uzorcima. Kada pritisnete OK, zatvo-

riñe se okvir za dijalog Page Properties i vratiñete se u dokument.

Dreamweaver nudi viãe unapred definisanih ãema boja nameçenih 
koriãñeçu na Webu. Odaberite Commands > Set Color Scheme da biste otvorili okvir za 
dijalog u kom moæete izabrati boje pozadine u levoj koloni, a boje teksta i hiperveza u sred-
çoj koloni. Desna kolona prikazuje izabranu kombinaciju. Pritisnite dugme Apply da 
biste u dokumentu pogledali zadate parametre boje bez zatvaraça okvira za dijalog. Pri-
tisnite OK da biste prihvatili izmene, zatvorili okvir za dijalog i vratili se u dokument.

4)  Izaberite tekst “Introduction to Lights of the Coast: Exploring Lighthouses”. 

Pritisnite dugme Text Color Picker na panou Properties.

Prikazañe se paleta boja pogodnih za koriãñeçe na Webu.

5)  Izaberite tamnoplavu boju (#003366).

Ponekad, kada primenite formatiraçe fonta, veliåine ili boje, poàa za te 
opcije na panou Properties ostaju prazna. Ako se to desi, osveæite prikaz na panou tako 
ãto ñete pritisnuti prozor dokumenta van teksta koji ste formatirali. Potom ponovo priti-
snite formatirani tekst i poàa na panou ñe prikazati vrednosti koje ste primenili.

Paleta Color se automatski zatvara kada pritisnete boju, a Dreamweaver boju 

odmah primeçuje. Sliåno opcijama za font i çegovu veliåinu, boja fonta je defi-

nisana pomoñu integrisanih opisa stilova. Primenom boje promeniñete stil koji je 

napravàen kada ste izabranom tekstu dodelili font. Ime stila ñe biti navedeno u 

meniju Style panoa Properties. Broj stila ñe se kod vas razlikovati od broja koji 

vidite u kçizi ako ste eksperimentisali sa atributima fonta, veliåine ili boje i 

napravili dodatne stilove.

Okvir za dijalog Colors otvoriñete ako odaberete Text > Color. Korisnici Win-

dowsa u çemu mogu odabrati boje koristeñi spektar boja i klizaå, mogu koristiti 

48 osnovnih uzoraka boje ili napraviti proizvoàne boje. Korisnici Macintosha u 

n a p o m e n a
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ovom okviru za dijalog mogu odabrati neku od razliåitih metoda biraça i defi-

nisaça boja, ukàuåujuñi opcije Color Wheel, Color Sliders, Color Palettes, Image 

Palettes (Spectrum) i Crayons. Heksadecimalnu vrednost boje moæete uneti i 

direktno u tekstualno poàe, odmah uz poàe Text Color na panou Properties.

Koristeñi pano Assets moæete voditi evidenciju heksadecimalnih boja 
koje ste koristili za Web prezentacije. Pano Assets se nalazi u grupi panoa Files. (Na 
Macintoshu, zbog greãke koju smo ranije pomenuli, grupa panoa Files moæda se zove 
Assets.) Pano Assets moæete odabrati i tako ãto ñete zadati komandu menija Window > 
Assets. Da biste doãli do uzoraka boje na ovom panou, pritisnite ikonicu Colors u koloni 
uz levu ivicu panoa. Uz vrh panoa nalaze se radio-dugmad pomoñu kojih moæete oda-
brati jednu od dve opcije za pregledaçe boja: Site i Favorites. Opcija Site prikazuje boje 
koje se veñ koriste u prezentaciji “Lights of the Coast”, odnosno u prezentaciji na kojoj tre-
nutno radite. Ako niste iskoristili nijednu boju, lista boja ñe biti prazna. Ukoliko ste defi-
nisali boje, ali one nisu nabrojane, pritisnite dugme Refresh Site List u doçem desnom 
uglu panoa. U listi ñete videti boje koje joã uvek niste koristili jer se one javàaju u doku-
mentima iz ostalih direktorijuma lekcija za projekat Lights of the Coast. Da biste dosledno 
koristili boje u celoj prezentaciji, na panou Assets moæete saåuvati najåeãñe koriãñene boje 
kao “omiàene” (Favorites). Da biste snimli boju, izaberite je u listi Site i pritisnite dugme 
Add to Favorites u doçem desnom uglu panoa Assets. Dreamweaver ñe prikazati okvir 
za dijalog u kom vas obaveãtava da je boja dodata listi omiàenih boja. Da biste videli tu 
listu, pritisnite radio-dugme Favorite na vrhu panoa Assets.

n a p o m e n a

lista site na panou assets �
u kojoj se vide boje �
upotrebàene u prezentaciji



DODAVAÇE SADRÆAJA WEB STRANI 63

DW04, May 6, 2004 9:50 am

DODAVAÇE SPECIJALNIH ZNAKOVA
Prilikom rada u Dreamweaveru, katkada zatrebaju znakovi kojima ne moæete 

pristupiti direktno sa tastature. Ovi specijalni znakovi imaju specifiåne HTML 

kodove ili alternativne preåice s tastature koje je teãko zapamtiti.

1)  Postavite kursor u nov red na samom dnu dokumenta introduction.htm.

Web strane åesto imaju podnoæja u kojima se nalaze informacije o autorskim 

pravima. U çima mogu biti i tekstualne hiperveze do glavnih odeàaka Web 

prezentacije, a ponekad i informacije o osobama za kontakt.

2)  Na traci Insert odaberite kategoriju Text. Pritisnite ikonicu menija Characters 

i znak © (copyright) da biste ga postavili u nov red na dnu dokumenta. Unesite 

2003, Lights of the Coast desno od umetnutog znaka zaãtiñenih autorskih prava.

Kao i u drugim menijima trake Insert, ikonica koja predstavàa meni Characters 

meçañe se na osnovu posledçe izabrane stavke menija.

Na Macintoshu: Ako ne vidite ikonicu menija Characters u kategoriji Text trake 

Insert, moæda morate da uveñate traku. Da biste to uåinili, pritisnite i povucite 

doçi desni ugao trake.

Znak © biñe postavàen u novi red kad pritisnete ikonicu u meniju znakova.

Mada se u meniju Characters u kategoriji Text trake Insert nalaze 
najåeãñe koriãñeni specijalni znakovi, to je daleko od sveobuhvatnog spiska. Ako znak koji 
vam treba nije u meniju Characters, odaberite opciju Other Characters na dnu menija ili 
izaberite Insert > HTML > Special Characters > Other. Kada u okviru za dijalog Insert 
Other Character odaberete znak, odgovarajuñi HTML kôd pojaviñe se u tekstualnom 
poàu u gorçem levom uglu okvira za dijalog. Kada odaberete znak koji hoñete da umet-
nete, pritisnite OK. 

kategorija text na traci insert meni characters

simbol copyright

n a p o m e n a
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DODAVAÇE HORIZONTALNIH LINIJA
Horizontalna linija    se pruæa preko cele strane i vizuelno odvaja delove doku-

menta. U ovoj veæbi, dodañete horizontalnu liniju iznad obaveãteça o zaãtiti 

autorskih prava.

1)  Postavite kursor na sam poåetak reda sa oznakom autorskih prava koji ste 

napravili u prethodnoj veæbi. U kategoriji HTML trake Insert, pritisnite dugme 

Insert Horizontal Rule.

Drugi naåin je da pritisnete dokument i izaberete Insert > HTML > Horizon-
tal Rule.

Poãto umetnete horizontalnu liniju, ona ñe ostati izabrana u prozoru doku-

menta. Biñe nacrtana neposredno iznad obaveãteça o zaãtiti autorskih prava, koje 

ñe pasti u red ispod horizontalne linije.

Ako ne vidite traku Insert, odaberite Window > Insert.

2)  Dok je horizontalna linija izabrana, upiãite 70 u poàe W na panou Properties. 

Izaberite % u meniju desno od broja koji ste upravo upisali.

horizontalna linija

s a v e t 1

n a p o m e n a
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Horizontalna linija ñe zauzeti 70 odsto ãirine (engl. width, W) prozora åitaåa, 

bez obzira na ãirinu samog prozora. Linija se prikazuje kao tanka pruga.

Ako hoñete da zadate apsolutnu ãirinu linije, izaberite opciju pixels 
u padajuñoj listi. U tom sluåaju, linija ne meça ãirinu kada korisnik promeni veliåinu 
prozora åitaåa.

3)  Dok je horizontalna linija izabrana, uklonite potvrdu iz poàa Shading na 

panou Properties. U poàe H upiãite 1.

Kad se ukloni potvrda iz poàa Shading, prikazuje se puna linija. Horizontalna 

linija je visoka (engl. height, H) 1 piksel.

Koristeñi meni Align, horizontalnu liniju moæete i da poravnate s levom margi-

nom, sa desnom marginom ili centralno. Horizontalna linija je podrazumevano 

centrirana i u ovoj veæbi ñemo koristiti to poravnaçe.

4)  Dok je horizontalna linija izabrana, pritisnite meni Class na panou Proper-

ties. Sa liste Class odaberite stil koji je nastao kada ste nalsovu dodelili tamno-

plavu boju. Snimite datoteku i pogledajte dokument u åitaåu.

Imena stilova koji se koriste u dokumentu ispisana su fontom i bojom koje ste za 

çih zadali. Ime stila koji ste izabrali trebalo bi da bude style1, ali se broj moæe 

razlikovati ako ste napravili joã neke stilove isprobavajuñi razliåite atribute fonta, 

veliåine ili boje. Mada ñe boja horizontalne linije u Dreamweaveru biti siva 

(podrazumevana boja), u åitaåu bi trebalo da bude tamnoplava.

Pogledajte horizontalnu liniju u åitaåu. Njen izgled moæete da promenite tako 

ãto ñete je izabrati i promeniti joj svojstva na panou Properties. Iznad i ispod hori-

zontalne linije nalazi se slobodan prostor åiju visinu ne moæete kontrolisati.

AUTOMATSKO DODAVAÇE DATUMA
Ponekad je bitno da znate kada ste posledçi put izmenili stranu u prezentaciji ili 

da posetioce obavestite kada je strana posledçi put aæurirana. Dreamweaver 

moæe da stavi datum i vreme posledçe izmene na sve strane prezentacije i da ih 

automatski aæurira svaki put kada snimite datoteku, da to ne biste radili ruåno.

To nije dinamiåki datum koji se meça svaki put kada korisnik pri-
stupi strani, nego datum koji govori posetiocima kada je posledçi put aæuriran sadræaj 
Web lokacije. Dinamiåki datumi se prave pomoñu JavaScripta o kom detaànije govori 
lekcija 11.

1)  Postavite kursor na kraj reda sa informacijom o zaãtiñenim pravima, napra-

vite nov red i unesite Updated:.

n a p o m e n a
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Datum se obiåno prikazuje u gorçem desnom uglu prezentacija novinskih agen-

cija ili na dnu strane ostalih informativnih prezentacija. 

2)  Odaberite kategoriju Common na traci Insert i pritisnite dugme Date da biste 

na stranu dodali tekuñi datum.

Otvoriñe se okvir za dijalog Insert Date. 

Okvir za dijalog Insert Date moæete otvoriti i pomoñu opcije menija Insert > 
Date.

3)  Iz menija Day format, izaberite opciju Thursday. Iz menija Date format, izabe-

rite opciju March 7, 1974. Iz menija Time format, izaberite opciju 10:18 PM. 

Potvrdite poàe Update automatically on save, pa ñe se datum aæurirati svaki put 

kada snimite dokument. Pritisnite OK.

Prikazuju se tekuñi dan, datum i vreme. Te informacije ñe se aæurirati svaki put 

kada snimite dokument. Thursday je u okviru za dijalog Insert Date koriãñen kao 

primer koji pokazuje kako ñe se u dokumentu prikazivati ime dana u sedmici. 

Primeri su i izabrane opcije za datum i vreme.

Format datuma koji se automatski aæurira moæete i kasnije da pro-
menite. Pritisnite datum u dokumentu, a zatim pritisnite ikonicu Edit date format na 
panou Properties. Otvoriñe se okvir za dijalog Insert Date. Promenite ãta hoñete i priti-
snite OK. Novi parametri biñe primeçeni na dokument. Format datuma koji se ne aæu-
riraju automatski ne moæe se meçati u okviru za dijalog. Da biste aæurirali te datume 
morañete sami da briãete i ponovo upisujete datum ili meçate tekst u prozoru dokumenta.

kategorija common �
na traci insert date (datum)

s a v e t 1
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DODAVAÇE FLASH TEKSTA
Prilikom postavàaça naslova na stranu, moæete da napiãete tekst i formatirate ga 

HTML oznakom Heading ili da napravite sliku i umetnete je (o grafiåkim ele-

mentima viãe ñete nauåiti u lekciji 3). Tekst formatiran kao naslov brzo se uåitava 

jer se radi samo o slovima, ali su moguñnosti biraça fonta i veliåine slova ograni-

åene. Koriãñeçe grafike kao naslova reãava problem biraça fonta, ali moæda 

nemate program za crtaçe ili nemate vremena da nacrtate potrebnu grafiku.

Flash tekst ima najboàe osobine obe opcije. Moæete da birate koji god hoñete 

font i da napiãete tekst direktno u Dreamweaveru. Tekst ñe biti snimàen kao 

mala Flash datoteka sa nastavkom .swf.

Mada je rad sa Flash tekstom brz i lak, pre nego ãto takav tekst dodate 
prezentaciji razmislite da li vaãa potencijalna publika ima odgovarajuñe dodatne pro-
grame za prikaz takvog teksta.

1)  Postavite kursor u prazan red novog pasusa, iznad liste koja poåiçe stavkom 

“The Lighthouses of Alexandria (Egypt)”. U meniju Media kategorije Common 

na traci Insert odaberite opciju Flash Text.

Pazite da ne pritisnete opciju Flash ili Flash Button. U ovoj veæbi radimo sa 

Flash tekstom. Opcija Flash omoguñava da na stranu postavite Flash animacije, 

a opcija Flash Button omoguñava izradu dugmadi.

Otvoriñe se okvir za dijalog Insert Flash Text.

2)  Promenite sledeñe:

• Iz menija Font izaberite Comic Sans MS. Ako taj font nije dostupan na 

vaãem raåunaru, izaberite neki drugi.

• U poàe Size upiãite 22.

• Na paleti Color izaberite tamnocrvenu boju.

• U poàe Text upiãite Some of the world’s most notable lighthouses include:.

• U poàe za boju pozadine (Bg color), upiãite #CCCC99, ili pipetom pritisnite 

pozadinu prozora dokumenta.

n a p o m e n a
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3)  U poàe Save as upiãite notable.swf  kao ime datoteke, pa pritisnite OK.

Zatvoriñe se okvir za dijalog Insert Flash Text. 

U poàu Save as biñe automatski ispisano podrazumevano ime dato-
teke. Ono ima numeriåki identifikator: text1.swf, text2.swf itd. Preporuåujemo vam da to 
opãte ime zamenite opisnim imenom. Flash tekst se podrazumevano åuva u istom direkto-
rijumu u kojem se nalazi HTML datoteka u koju ubacujete Flash tekst, ali moæete odabrati 
i neko drugo mesto (na primer, direktorijum sa slikama ili multimedijalnim datotekama).

Flash tekst ñe se pojaviti u dokumentu. Na panou Properties videñete svojstva 

datoteke notable.swf.

4)  U prozoru dokumenta izaberite Flash tekst i povucite jednu od ruåica da biste 

mu promenili veliåinu.

Nije vaæno koliki je Flash tekst. To je vektorski objekat, a ne obiåan tekst ili 

rasterska slika, pa moæete da mu meçate veliåinu direktno u prozoru dokumenta. 

Veliåinu slike moæete meçati ne brinuñi o gubitku çenog kvaliteta.

Ne preporuåujemo da meçate veliåinu slika u Dreamweaveru (ãto je obja-

ãçeno u lekciji 3). Veliåinu Flash teksta moæete da meçate, jer se radi o vektor-

skoj grafici. Vektorska grafika zadræava isti kvalitet prilikom promene veliåine, 

za razliku od rasterske (kao ãto su slike u formatima GIF i JPEG).

Dok meçate veliåinu Flash teksta, dræite taster Shift, jer ñe tako odnos ãirine 
i visine slike ostati nepromeçen. 

n a p o m e n a
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5)  Snimite datoteku i pogledajte je u åitaåu.

Tekst izgleda isto kao u Dreamweaveru.

Flash tekstu moæete dodeliti i hipervezu i boju za efekat prelaza. Dugme 
Play na panou Properties omoguñava da takve efekte pregledate u samom Dreamweaveru. 
S hipervezama ñete raditi u lekciji 4, a s efektima prelaza i ostalim interaktivnim elemen-
tima u lekciji 11.

MEÇAÇE FLASH TEKSTA
Meçaçe Flash teksta u Dreamweaveru je lako. Moæda ñete morati da izmenite 

reåenicu, upotrebite drugi font ili na neki drugi naåin izmenite sadræaj teksta.

1)  U prozoru dokumenta dvaput pritisnite Flash tekst.

Ako tekst ne moæete da izaberete, najpre pritisnite dugme Stop na panou 
Properties.

Otvoriñe se okvir za dijalog Insert Flash Text.

2)  Promenite opcije kako god hoñete i zatim pritisnite dugme Apply da biste 

videli rezultate izmena. Kada zavrãite meçaçe i provere, pritisnite OK i okvir 

za dijalog ñe se zatvoriti.

Izmeçeni Flash tekst biñe osveæen na strani, a .swf datoteka aæurirana.

ÃTA STE NAUÅILI
U ovoj lekciji ste:

• nauåili kako se zadaju parametri teksta i kako se tekst uvozi na razne naåine 

(strane 40–45)

• smeãtali tekst u pasuse, poravnavali ga i prelamali redove teksta (strane 

45–47)

• napravili tri vrste lista i meçali çihova svojstva (strane 47–52)

• formatirali stil, veliåinu i boju teksta pomoñu okvira za dijalog Page Proper-

ties i panoa Properties (strane 52–54)

• meçali kombinacije fontova i çihove parametre (strane 54–62)

• dodavali strani specijalne znakove (strane 63–65)

• dodali strani datum i zadali da se automatski aæurira svaki put kada se strana 

snimi (strane 65–66)

• pravili i meçali Flash tekst (strane 67–69).

n a p o m e n a
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